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Introduction





This file contains the Lil’ WOPRs for WOPR 6 — the WinWord utilities that you’ll use day in and day out. Several of the LittleWOPRs from WOPR 2 are making a reappearance, but others have been replaced by new features of WinWord 6. We’ve also added a few new ones.


The Stellar Spellar gives checks your spelling with a single click of the right mouse button. ViewCharacters tells you what codes lie behind your inscrutable characters. View�Header, believe it or not, brings back the WinWord 2 functionality. Duplicate Style lets you make an exact copy of an existing style...something WinWord 6 left out. Edit�eplace allows you to kick off the process with the currently selected text. FastFind finds the current selection quickly; just highlight and press the quick-keys. FileDelete closes and deletes the current document...without any hassles. Fix LineBreaks removes the extra line breaks of imported ASCII Text files. Normal Quotes converts the “smart quotes” back into normal quotes. WOPRStyle gives you a convenient dialog window of your Styles that’s always there where you need it. ZipDial finds Zip codes using your modem.


You’ll find more details in the following sections.
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Stellar Spellar


WOPR's Spellar is a Word 6.0 Add-In that gives you quick access to Word's spelling and thesaurus functionality. 


To use Spellar, just click your right mouse button over a word in your document.


If the word is misspelled


If the selected word is misspelled, Spellar queries Word's spell files for suggestions. The first five suggestions are displayed on the shortcut menu. Select one of the words and Spellar changes the word in your document to the selected word. If no suggestions are found in Word's spell files, the text "(no suggestion)" will appear on  the shortcut menu instead of the suggestions.


If the word is spelled correctly


If you click on a word that is spelled correctly, the text on the menu will read:


*** The


*** word


*** is


*** spelled 


*** correctly :)





Creating AutoCorrect entries with Spellar


If you commonly misspell a word, you can add the correction to Word's AutoCorrect feature so that the word is corrected as soon as it is typed. To create the AutoCorrect entry using Spellar, do the following:


1.	Right click on the misspelled word. 


2.	Press and hold the CTRL key.


3.	Select the correct word from the shortcut menu.


Spellar has created an AutoCorrect entry. In the future when you mispell the word, Word will automatically correct the misspelling.


Check Spelling and Thesaurus


Choose Check Spelling... and Spellar will display Word's Spelling dialog.


Choose Thesaurus... and Spellar will display Word's Thesaurus dialog.


Removing/Uninstalling Stellar Spellar


If you need to remove the Stellar Spellar from your system for any reason, create and run a macro with the following text:


Sub Main


	WOPRSpellerUninstall


End Sub





After running the above macro, choose Templates from the File menu of Word. Clear the speller.wll check box and choose the OK button. Now, remove the SPELLER.WLL file from your WinWord\Startup directory.


Troubleshooting - WOPR6WAYCOOL1-WOPR6WAYCOOL5 on shortcut menus.


After the Stellar Spellar is installed, WOPR6WAYCOOL1-5 text is added to Word's shortcut editing menus. The five text items are used as placeholders. When you evoke WOPR Spellar (left click on a word), the WOPR6WAYCOOL text is changed to Word's spelling suggestions on the fly. If you have unloaded the SPELLAR.WLL file, the WOPR6WAYCOOL text will still appear on the menu. To load the speller add-in (SPELLER.WLL), use Word's File Templates dialog.
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ViewCharacters


View Characters is a simple little macro you can use to determine the ASCII character code for a character in your document. 


1.	Select a character or group of characters in your document and run the ViewChars macro.


2.	A dialog appears displaying the ASCII character code(s) and the font of the character. If you selected more than one character, each time you press the OK button the dialog updates with the next character code.


Often, you need to know the character code in order to search and replace the character in your document. In the Find What edit box of Word's Edit Find or Edit Replace dialog, type ^0nnn where nnn is the character code number.


NOTE: WinWord Tables are weird! If you select a table cell, the Selection$() WordBasic function will return an empty string! You also can't select the table-cell marker, but if you select more than a row of a table, these markers appear as Chr$(13)+Chr$(7) pairs. ViewChars does its best to give you accurate results, but the cursor on the screen will jump around a bit. Finally, you will get incorrect results if you select a column in a table.
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ViewHeader


WOPR ViewHeader brings back the Word 2.0 functionality of choosing Header/ Footer from the View menu. This utility does not switch you to Page Layout, but rather resurrects the ol' header/footer pane along the bottom of the document window.


If you’ve ever tried to create a WinWord 6 template that contains custom headers and footers, you’ll soon discover that you can’t get to the additional Odd/Even headers unless your template is several pages long (by inserting manual page breaks). Ugly. With WOPR ViewHeader, you can get to those extra headers and footers without those page breaks!


Run the ViewHeader macro and a reproduction of the Word 2.0 Header/Footer dialog is displayed. Select the type of header/footer you want to edit and choose the OK button. A window pane at the bottom of the window is opened with the contents of the header/footer you specified. Change the text as needed and click the Close button to return to Word.


Buttons from left to right function are as follows:


Insert page number field


Insert current date


Insert current time


Link header/footer to the header/footer of the previous section
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WOPR All Keys


This macro generates a table of all key assignments. If you do any extensive customization of WinWord, you need this table!


The built-in assignmets are in black, and custom assignments are formatted in Blue. Additionally, a custom assignment has either a † or ‡ after the macro name. The single dagger (†) indicates that the assignment is in NORMAL.DOT, and the double dagger (‡) indicates the assignment is in an Add-In or the active template.


The table formatting is not the greatest in the world, but it does its job.
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WOPR Duplicate Style


This macro allows you duplicate a style in your document. Instead of defining your styles from scratch, you can use DupStyles to duplicate an existing style. After the style is duplicated, you can make minor changes to the new style name. For example:


1.	Run the WOPRDupStyle macro (Format, Dup Style menu).


2.	Select a style from the list box of existing styles. This should be the style you want to duplicate. Character styles are indicated with “(character)” next to the style name.


3.	Type a style name in the New Style Name edit box and choose the OK button.


A new style is created with the same formatting attributes as the style selected in Step 2 above. 


4.	From the Format menu choose Style. Select the new style name from the Styles list box and click the Modify button. Click the Format button and select the formatting attribute that you want to modify.


For more information on working with styles, see chapter 9 in the Word 6.0 User's Guide.
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WOPR EditReplace


WOPR EditReplace allows you to quickly replace selected text in your document. This is a very simple macro that kick starts EditReplace by throwing the currently highlighted text into the “Find What:” edit box.


1.	Select a word in your document.


2.	Run the EditReplace macro (Edit, Replace... menu). The selected text appears in the Find What dialog. Type replacement text into the Replace With dialog and click the Replace or Replace All button.
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WOPR FastFind


WOPR FastFind allows you to quickly jump to the next or previous occurrence of the selected text. Instead of fumbling around with Word's Edit Find dialog, just select a word and run WOPR FastFind.


1.	Select a word in your document.


2.	To search forwards through your document for the next occurrence of the word, run WOPRFastFindFwd (ALT+Z), and to search backwards run WOPRFastFindBck (SHIFT+ALT+Z). 


Using Word's Tools Customize dialog, you can assign the WOPRFastFindBck or WOPRFastFindFwd macros to any key, menu or Toolbar button. 


If a word is not selected when you run the WOPR FastFind macros, the Edit Find dialog box is displayed.
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WOPR FileDelete 3.0


This macro closes the current document and all related macro windows and then deletes the file from disk. If the document is an Add-In or a Global macro, it will not be deleted.


Prior to deleting the file, you are presented with the following prompt:


Are you sure you want to delete the file xxxx.xxx?


Choose the Yes button if you want to delete the indicated file.
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WOPR Fix LineBreaks


Ever import some ASCII text (from e-mail or other ASCII documents) and you wanted to get rid of all those line breaks? Well, this is the macro for you!


Just run WOPRFixLineBreaks (Format, Fix LineBreaks menu). If a block of text is highlighted, then only that selection will be affected. Otherwise, the entire document is converted.


The algorithm goes like this:


1.	Replace all double carriage-returns (“^013”) with a temporary mark, “\[“.


2.	Replace all remaining carriage-returns with a space.


3.	Replace all temporary marks (“\[“) with a carriage-return.


Obviously, this method is not foolproof, but should work in a great majority of cases. If you’re making changes in a large file, the replacements may take a while. You may also be warned by WinWord that the operation may not be undone because of the large number of replacements.


Also, if your document is really a TEXT file or WinWord 2 file (not yet saved as a WinWord 6 file), then you may need to change the macro to use “^p” instead of “^013”.


But since “^p” is not used across all language versions of WinWord for carriage-return, we hesitated using it for this macro. You need to substitute the correct one for your version.
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WOPR Insert ClipArt


This macro is truly.....er.....a work of art, if we may say so ourselves!


When you first start the WOPRInsertClipArt macro (Insert, ClipArt menu), the macro will search through your WinWord 6 Clipart directory for a list of graphics files. A dialog box comes up telling you its progress.


If you’re using an evaluation copy, the nag screen flashes for a few seconds before the macro continues.


Then simply choose the graphics you need from the preview and click Insert to put it into your document! If there are more graphics that can fit in the dialog box, you can click the NextScreen and PrevScreen buttons to page through the list.


You can define custom search directories for your clipart files or even use FileFind to build the clipart list.
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WOPR Normal Quotes


The new WinWord SmartQuote AutoCorrect feature is great most of the time, but every once in a while, you’ll run into a situation where you want just the normal straight quotes. Peter Deegan comes to the rescue with WOPRNormQuote.


If you highlight a section when you run WOPRNormQuote, (Format, Norm Quote menu), only the SmartQuotes in the selection will be changed. Otherwise, the entire document is converted.
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WOPR Style


Do you hate the drop-down style list box? Is the style you want always way down the list?


If so, you’ll love WOPRStyle. Just click on the icon in the WOPRToolbar that looks like a shiny document (the same one MS uses for AutoFormat), and you’ll get a popup dialog window. You can size it anyway you want to show the styles you’re interested in.


Click on the Settings to change the type of styles to display in the list.


One caveat: I you use a virtual desktop utility (TopDesk from the Windows Resource Kit, PCTools Desktop, Dashboard, etc.), WOPRStyle may prevent you from switching to the other desktops. Just close WOPRStyle dialog by double-clicking on the hyphen thingee to the left of its title bar. When you need it again, it’s only one click away!
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